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1 Installation Guide for Avid Editing 
Applications

Thank you for purchasing an Avid Editing System. This guide is intended to assist you with 
installing and starting your application. You will also find information on how to activate your 
software and how to install any third party software. Additionally, instructions on how to 
deactivate and uninstall your Avid product can be found in this guide. You can always find the 
most current information in the online version of the ReadMe, and should check there for the 
most recent release notes. The online version is updated immediately after new information 
becomes available. You can find the ReadMe on the Knowledge Page by clicking ReadMe under 
the Help menu in your application. The ReadMe can also be found on your Account Page.

Before Installing

It is recommended that you read through the procedures prior to starting your installation in 
order to familiarize yourself with the process. To begin, please close any unnecessary windows 
or programs to ensure best performance. You will have to restart your computer in order to 
complete the installation process. 

It is important that you check the ReadMe on the Knowledge Page to make sure your system is 
properly configured to work with your new software.

New Users
If you are a new Avid customer or have never installed this program before, the following 
instructions will help guide you through the process.

Returning Users
If you are upgrading from a previous version of the editing application, you must first uninstall 
the previous version before you install and activate your new software. You will need your 
original System ID to activate your upgraded product. After you uninstall your old application, 
the installation process will be identical to the standard installation. See “Upgrading the Avid 
Editing Application” on page 10.

http://www.avid.com/US/support
https://account.avid.com/
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Installing the Avid Editing Application

For all Avid editing applications, log in as an OS user with administrative privileges and launch 
the installer. After installation and after the required system reboot, you need to run the 
application as a user with administrative privileges. If you are working in a shared storage 
environment, mount your workspaces. You can then run the Avid Editing Application as a 
standard user. 

n Installing the editing application software might take some time. For the individual editing 
application, it might take 5 to 15 minutes to install. Installing the entire editing application suite 
might take up to 35 minutes to install.

(Windows) To install the Avid software:

1. Download the Avid editing application software from your download page.

2. Click to launch the Avid Editor Suite installer to install the editing application and Avid 
helper applications or an individual product. A window will open with instructions as well as 
options for choosing file locations and other custom settings.

3. Follow the on screen instructions.

- If the FilesInUse dialog box appears, you can safely select Ignore and continue.

- If you receive user access warnings during the installation, select Continue Anyway to 
continue your installation.

4. When prompted, choose to restart the computer.

(Macintosh) To install the Avid Editing application software:

1. Download the Avid editing application software from your download page.

2. Double-click the .pkg file with the editing application name.

3. Click to launch the installer.

A window will open with instructions as well as options for choosing file locations and other 
custom settings.

4. Follow the on screen instructions.

5. When prompted, choose to restart the computer.

Starting the Avid Editing Application

The installation process adds a Desktop icon (Windows) or Dock icon (Macintosh) and a pointer 
to your Avid editing application in the Start menu (Windows). 
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On Windows, upon launch, a dialog box might open with a message about incompatible power 
management schemes or will automatically switch you to the “Windows 7 Basic color scheme”. 
Avid recommends you use the “High Performance” power option for Windows 7 when you work 
with the Avid editing application. After installing and opening your application for the first time, 
you will have to activate and license your new software. 

(Windows) To start your Avid editing application, do one of the following:

t Click Start > All Programs > Avid > Avid editing application.

t Double-click the Avid editing application desktop icon.

The Welcome window opens. 

(Macintosh) To start your Avid editing application, do one of the following:

t Click the alias icon for your Avid editing application on the Dock.

t Select Go > Applications, and double-click the Avid editing application folder. Then 
double-click the Avid editing application file.

The Welcome window opens.

The Welcome window prompts you to activate your software. Until you activate your 
software, the Welcome window will open each time you launch the application. The 
following sections outline the activation options.
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t Select one of the options to activate your software.

- To activate using Electronic Activation, select “I want to activate my software using the 
Internet, another computer, or a volume license server,” click Continue. 
The Avid License Control tool opens. Read “What Will I Need for Electronic 
Activation” below and then continue to the next page for information on activating the 
software.

- To activate with a Hardware Key or dongle, select “I want to use a dongle to activate my 
software,” attach your entitled dongle and then click Continue.
The system confirms your information. When the activation is complete, a message 
informs you that your software has been successfully activated.

- To run in Trial Mode, select “I want to run a fully-featured trial version of the Avid 
editing application for 30 days,” click Continue.
Files and projects created during Trial Mode will not be compatible with any licensed 
versions unless you purchase and activate a permanent license. Avid recommends you 
activate your product immediately if you already have an Activation ID.

Avid License Control can also be launched as a utility application:

- (Windows) Start > All Programs > Avid > Utilities > Avid License Control

- (Macintosh) Mac HD/Applications/Utilities/Avid 
Utilities/LicenseControl/AvidLicenseControl

What Will I Need for Electronic Activation?
Activation ID

Your activation ID is needed to activate your software. You can find your activation ID by going 
to your Avid account. The ID is listed on the “My Products” page and with your downloads. You 
will also receive an email which contains activation codes for each of your downloaded 
programs.

System ID

Your System ID is a unique number for your system. You can find your System ID in several 
places: 

• If you purchased a new physical kit, you can find your System ID listed on the back of the 
Activation Card below your Activation Code. 

• You can also find your System ID online by going to your Avid account. If you are an 
upgrade customer, you will need the System ID from your current product. You can find the 
System ID using the Avid License Control Utility's License Profile tab.

http://account.avid.com/.
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To find the System ID on your current product:

• Your System ID is displayed on the splash screen. To display the splash screen while in the 
application, select the Help drop menu on Windows or the menu with your product’s name 
(for example, Avid Media Composer) on Macintosh and click About your product's name 

• You can also find your System ID on the console. To locate your ID in the console, from 
Tools select Console. Scroll down to find your System ID and other information about your 
system.

• Once activated, the License Profile tab on the Avid License Control tool displays 
information about your system.

Device ID

Your device ID identifies your system if you are activating your software on a system that is not 
connected to the internet. This ID will be provided to you through the Avid License Control tool 
during the activation process. 

Customers with ExpertPlus or Elite support plans

You need to download the FlexVersioner.avd file from the Download Center

Activating with an Internet Connection

1. With the Avid License Control tool open, click the Activate button next to the Avid editing 
application.

The Activation window opens.

2. Select “I am connected to the Internet and will use this computer,” then click Continue.

A window opens which allows you to enter system information and register your product.

3.  Enter the appropriate information in each field; System ID followed by your Activation ID. 

4. Be sure that you agree with Avid's privacy policy prior to installing or using the application. 
Click Read Privacy Policy.

The Avid License Control tool confirms your system information. When the activation is 
complete, a message informs you that your software has been successfully activated.

http://www.avid.com/US/support/find-support/category/updates
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Activating without an Internet Connection

1. With the Avid License Control tool open, click the Activate button next to the Avid editing 
application.

The Activation window opens.

2. Select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet,” then click Continue.

3. Enter your system identification number in the System ID text box. 

4. Enter your activation identification number in the Activation ID text box. 

5. Click Next.

Your device ID will display at the bottom of the Activation page. 

6. Record this number for later use.

7. Follow the on screen instructions then click Next.

8. On a computer with an Internet connection, go to http://avid.com/license.

9. Follow the onscreen instructions on the web page. You will need to enter your System ID, 
Activation ID and Device ID.

The website creates a license.bin file. This file contains license information needed to 
activate your Avid editing application.

10. Once you have the license.bin file, transfer it to the system you want to activate.

11. At the system you want to activate, in the Avid License Control tool, click Browse and 
navigate to the license.bin file you just brought to your system, then click Open.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the button 
changes to Deactivate.

12. Repeat these steps for each editing application or additional option you need to activate.

13. If the editing application is open, exit and restart for the changes to take effect.

Upgrading the Avid Editing Application

You can upgrade your Avid editing application from either an existing software license or a 
dongle license.

http://avid.com/license
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If you purchased PhraseFind, ScriptSync or a Language Pack, your license activation will 
automatically carry over from your previous version and update. Do not deactivate PhraseFind or 
ScriptSync if you are upgrading your Editing Application. If you purchase new options, you will 
receive a new Activation ID in your avid.com account.

n Upgrading your dongle license to a software license disables your dongle. Once you have 
activated your software license, you do not need and are not able to use the dongle to run your 
Avid editing application.

If you activate electronically with a dongle attached, the system assumes you are converting from 
a dongle license to a software license and the dongle will be disabled. Only activate 
electronically with a dongle attached if you wish to convert to software licensing. 

Customers with active ExpertPlus or Elite support plans: If you upgrade your existing 
license and have an active ExpertPlus or Elite support plan, please carefully read all the 
instructions provided on the Download Center before updating your system. All customers with 
these plans must use the FlexVersioner.avd file to upgrade their software. For additional 
information, please check the “Software Licensing Upgrade Process for Support Customers” 
topic on the Avid Knowledge Base.

Upgrading with an Internet Connection from an Existing Software 
License

To upgrade:

1. Open the Avid License Control tool. You can launch the Avid License Control tool by 
clicking on an activation option in the Welcome window or by going to the following 
location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

2. Launch the Avid License Control tool.

3. Click Activate next to the Avid editing application.

The Activation window opens.

4. Select “I am connected to the Internet and will use this computer,” then click Continue.

A window opens which allows you to enter system information and register your product. 

5. If your System ID does not display, enter your system identification number in the System 
ID text box. 

n If your previous editor included purchased options, for example PhraseFind or ScriptSync, these 
options will activate automatically with your upgrade.

6. Enter your new activation identification number in the Activation ID text box.

http://avid.force.com/pkb/articles/en_US/faq/en262969
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The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated.

7. Click OK. 

Upgrading with an Internet Connection from a Dongle License and 
Converting to a Software License

To upgrade your Avid editing application with an Internet connection from a dongle 
license to a software license:

1. Attach your dongle to your Avid editing system.

2. Go to the following location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

3. Launch the Avid License Control tool.

4. Click Activate next to the Avid editing application.

The Activation dialog box opens.

5. Select “I am connected to the Internet and will use this computer,” then click Continue.

A window opens which allows you to enter system information and register your product. 

6. If your Systems ID does not display, enter your system identification number in the System 
ID text box.

n If your previous editor included purchased options, for example PhraseFind or ScriptSync, these 
options will activate automatically with your upgrade.

7. Enter your new activation identification number in the Activation ID field.

8. When asked if you want to deactivate your dongle, click OK.

The Activation tool confirms your system information. When the activation is complete you 
will receive a message indicating the software has been successfully activated.

9. Click OK.

Your dongle is now deactivated and you can run the application with a software license.

Upgrading without an Internet Connection to a Software License
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To upgrade your Avid editing application without an Internet connection to a software 
license: 

1. Go to the following location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

2. Launch the Avid License Control tool.

3. Click Activate next to the Avid editing application.

The Activation window opens.

4. Select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet,” then click Continue.

5. If your Systems ID does not display, enter your system identification number in the System 
ID text box. 

n If your previous editor included purchased options, for example PhraseFind or ScriptSync, these 
options will activate automatically with your upgrade.

6. Enter your activation identification number in the Activation ID text box.

7. Click Next.

8. Follow the displayed instructions to note your System ID, Activation ID and Device ID, then 
click Next.

9. On a computer with an Internet connection, open a Web browser and navigate to 
http://avid.com/license.

10. Follow the onscreen instructions. You will need to enter your System ID, Activation ID and 
Device ID.

The website creates a license.bin file. This file contains license information needed to 
activate your Avid editing application.

11. Once you retrieve the license.bin file, transfer it to the system you want to activate.

12. In the Avid License Control tool, click Browse and navigate to the license.bin file on your 
system, then click Open.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated

13. Repeat these steps for each editing application or option you need to activate.

14. If the Avid editing application is open, you should exit and restart for any changes to take 
effect.

http://avid.com/license
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Upgrading with a Dongle

If you have purchased an upgrade for your Avid Editing Application and wish to continue using 
your dongle, you will need to obtain an updater file. 

To upgrade your Avid editing application with a dongle:

1. Go to your Avid Account and locate the Activation ID included with your upgrade.

2. Go to www.avid.com/upgrade and choose “Upgrade Your Existing Dongle.” Enter your 
Activation ID, as well and your dongle’s System ID and Dongle Serial Number. These can 
be found on the tag attached to your dongle or by using the Dongle Manager utility.

You will receive an updater file in an email.

If have an ExpertPlus or Elite support plan: Download the FlexVersioner.avd from the 
Download Center. This file can be used as a dongle updater.

To Update the dongle:

1. Make sure you have your dongle attached to your Avid editing system.

2. Navigate to the directory where the DongleManager.exe is installed:

(Windows) C:\ProgramFiles\Avid\Utilities\DongleManager

(Macintosh) Macintosh HD\Applications\Utilities\Avid Utilities\DongleManager

3. Launch the DongleManager.exe

4. Click the Update tab.

5. Click Open and navigate to the location of your dongle updater (.avd) file.

6. Open the updater file.

7. Click Update.

The DongleManager.exe application updates your dongle and displays that your verification 
is complete.

8. Start your Avid editing application.

The Welcome window opens.

9. Select “I want to use a dongle to activate my software.”

10. Click Continue.

The system confirms your information. When the activation is complete, a message informs 
you that your software has been successfully activated.

https://account.avid.com/
http://www.avid.com/US/support/upgrade/video
http://www.avid.com/US/support/find-support/category/updates
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Upgrading Using the FlexVersioner.avd File

This procedure is for ExpertPlus and Elite Support plan customers only.

Perform the following procedure after installing the new version of the editing application but 
before launching for the first time.

To upgrade your Avid editing application using the Versioner.avd file: 

1. Download the Versioner.avd file for your editing application.

2. Place the Versioner.avd file in the editing application folder:

(Windows) [drive]:/Program Files/Avid/[Avid editing application]

(Macintosh) Macintosh HD/Applications/[Avid editing application]

3. Start your Avid editing application.

The Avid License Control tool opens. 

4. Click Activate next to the Avid editing application.

5. Do one of the following:

t Select “I am connected to the Internet and will use this computer.”

t Select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet.”

6. If you selected to use this computer:

a. Select your registration option. Your System ID and new Activation ID should 
automatically populate their fields.

b. Click Activate.

7. If you selected to use another computer:

a. Your System ID and new Activation ID should automatically populate their fields.

b. Click Next and follow the onscreen prompts. You will be instructed to take note of your 
System ID, Device ID, and Activation ID. 

c. On the Internet-connected computer go to www.avid.com/license to enter this 
information and obtain a license.bin file.

d. Take that bin file back to the editor. Use Avid License Control to open the bin file and 
activate your system.

http://www.avid.com/US/support/activate
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Additional Options and Features

In addition to activating the Avid Editing Application, there are several editing options or 
features that can be activated through the Avid License Control tool. You can purchase these 
additional products by going to the Avid web store and clicking on Software Options for Video 
Editing. You may also have several pieces of free third-party software included with your 
purchase. You may find the installers for these products on your Downloads Page in your Avid 
Account. If you purchased the USB drive, you can find these installers in your “Production 
Suite” folder in the “Additional Files” directory. 

Below are descriptions for some of the additional options and features available for your product.

Production Suite 3rd-party applications

Avid Editing Applications come bundled with 3rd-party software such as Sorenson Squeeze, 
Avid FX, Boris Continuum Complete, and Avid DVD. Which applications are included depends 
on which editing application you have. If you purchased a new copy or upgrade of the Avid 
Editing Application, you will find activation codes included in your Avid Account. If you are 
covered by an ExpertPlus or Elite support plan, or are a student with Avid Media Composer 
Academic and are within your no-charge upgrade period of 4 years, you can obtain activation 
codes by entering your System ID at www.avid.com/mc3party.

PhraseFind

PhraseFind is a powerful option that searches through your clips using phonetic find to save you 
time and money. This tool allows you to quickly find audio dialogue throughout bins in a single 
project. PhraseFind is purchased separately and includes a free language pack of your choice. 
For more information, simply click the product name above or visit the Avid Store page to buy.

PhraseFind Language Packs

PhraseFind has the ability to sift through dialogue in a variety of languages to help you sort and 
find the audio that you need. Languages available for purchase include Dutch, French, German, 
Latin American Spanish, North American English, United Kingdom English and Russian. Click 
the title to learn more.

http://www.avid.com/US/products/phrasefind
http://shop.avid.com/store/product.do?product=307190015850032
http://shop.avid.com/store/home.do
http://shop.avid.com/store/category.do?category=avid-video-effects
http://shop.avid.com/store/category.do?category=avid-video-effects
https://account.avid.com/
https://account.avid.com/
http://apps.avid.com/ThirdPartyTool/
http://shop.avid.com/store/product.do?product=307190015853600
https://account.avid.com/
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ScriptSync

ScriptSync uses phonetic-indexing technology to analyze the audio of a clip and match it to lines 
of the script text. This tool can exponentially decrease the time spent editing scripted and 
transcripted material along with a variety of other applications. ScriptSync boasts a host of 
powerful features and capabilities which can accelerate your workflow. For more information, 
click the product name above or visit the Avid Store page to buy.

AVCHD Dolby AC-3 import or link to AMA

The AVCHD Dolby AC-3 feature only appears if you use this format. You will not normally see 
this option in the Avid License Control tool. This feature is used to import or AMA link to 
AVCHD transport stream (.mts) files. If you are not connected to the Internet for the first time 
you import or AMA link to .mts files, the system opens a dialog box and then the Avid License 
Control tool. Follow the onscreen instructions to activate this feature. If you are connected to the 
Internet, activation is automatic. For more information, please visit the Avid Knowledge Base.

Running the 30-Day Trial
Before you purchase an Avid Editing Application or any additional options, you can test each 
product for a 30-day trial period. If you run the Avid Editing Application trial, you also get a 
30-day trial of PhraseFind and ScriptSync. This trial also includes all available language packs. 
Please note that any bins or projects you create during the 30-day trial will only be usable when 
you activate a full editing license. To purchase the Avid Editing Application during the or after 
the 30-day trial, simply go to the Avid web store.

You can also run a 30-day trial of any of the additional features, such as PhraseFind or 
ScriptSync. After your trial expires, you will no longer be able to use the product or feature. The 
system will keep you informed of how many days you have left before the trial ends. 

To use your Avid editing application for a 30-day trial period:

1. Start your Avid editing application.

The Welcome window opens.

2. Select “I want to run a fully-featured, trial version of the Avid editing application for 30 
days.”

3. Click Continue.

Your software has been temporarily activated. At any time during or after the 30-day trial 
period, you can choose to purchase a copy of your Avid editing application from the Avid 
web store. If you choose not to purchase the software, your Avid editing application is 
deactivated when the 30-day trial expires.

http://shop.avid.com/store/home.do
http://shop.avid.com/store/home.do
http://shop.avid.com/store/product.do?product=306834737184096
http://www.avid.com/US/products/scriptsync
http://avid.force.com/pkb/articles/en_US/troubleshooting/en367791
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To run PhraseFind for a 30-day trial period:

1. Open your Avid editing application and an Avid project.

2. Press Ctrl+F or Command+F or select Edit > Find.

The Find window opens.

3. Type a word or phrase in the text box, then click the PhraseFind button.

The system checks to see if you have PhraseFind on your system and then a dialog box 
opens.

4. Click Run Trial.

The system restarts your Avid editing application and you then have access to PhraseFind.

Your 30-day trial of PhraseFind also includes access to all available languages during the 
trial. 

5. In the PhraseFind window, select your language from the Select a Language menu and wait 
for the PhraseFind Index to turn solid green before proceeding.

6. You can buy PhraseFind at any time during the trial by clicking “Buy” after clicking the 
PhraseFind button.

To run ScriptSync for a 30-day trial period:

1. Open your Avid editing application and an Avid project.

2. Create a script, File > New Script.

3. Browse to your script then click Open.

4. In the script, click the section where you want to place the clip (take).

The section highlights.

5. From a bin, drag the clip to the selected section in the script.

The box below the clip in the script, should highlight black. This indicates that the clip is 
selected in the script.

6. Select Script > ScriptSync.

The system checks to see if you have ScriptSync on your system and then a dialog box 
opens.

7. Click Run Trial.

You have immediate access to the ScriptSync window.

8. You can buy ScriptSync at any time duing the trial by clicking the “Buy” button on the 
dialog box that informs you how many days you have left on the trial.
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Deactivating the Avid Editing Application and 
Options

If you need to move your Avid editing application to a different computer, deactivate the Avid 
editing application and options before you uninstall the Avid editing application. If you uninstall 
your software first, you may not be able to retrieve your system or activation ID. 

Deactivate PhraseFind and ScriptSync first, then deactivate the Avid editing application.

n You must have an Internet Connection to deactivate the software and its options.

Deactivating the Avid editing application and options:

1. From your Avid editing application, select Special > Deactivate Software License.

2. A message appears informing you that the Avid editing application will close and the Avid 
License Control tool will open, click Continue.

3. A dialog box opens and asks if you want to leave the Avid editing applications, click Leave.

4. Or go to the following location to open the Avid License Control tool:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens. 

5. Next to the any of the options, click Deactivate.

If you are deactivating PhraseFind, a message appears informing you that the language 
packs associated with PhraseFind will also be deactivated. 

6. Click Yes.

The system deactivates the selected item and the button changes to Activate.

7. Click Quit to close the window.

Uninstalling the Avid Editing Application

For all Avid editing applications, log in and initially start the application as a user with 
administrative privileges. If you are working in a shared storage environment, mount your 
workspaces. You may then subsequently run the Avid editing application as a regular User.

(Windows) To uninstall the Avid editing application software do one of the following:

1. Quit all active applications.

2. Access the Control Panel and select Programs and Features. Then select the editing 
application and click Uninstall.
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(Macintosh) To uninstall the Avid editing application software:

1. Quit all active applications.

2. Go to Applications/Avid_Uninstaller/AvidEditingApplication.

3. Double-click the AvidEditingApplication uninstaller.

4. Follow the on-screen prompts.
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